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Introduction 
The objective of this guide is to provide information and helpful tips for creating graphics in Microsoft Word 2016. 

Hopefully, it will give you all the guidance you need to create effective graphics. However, the Editing department 

is always available to help.  

Graphic Elements–When Should We Use Them?  
We all love graphic elements. They can provide additional information to the reader and make a report look more 

interesting. However, more is not always better! Using too many graphic elements can make the report look messy 

and make the information hard to follow. The key question we should ask ourselves is this: 

Is this graphic adding something important to the report? 

Let’s take a look at some examples: 

 

 

In this example, the chart illustrates information that is already in the body of the report. Readers don’t need the 

same information twice. While the graphic may look nice, the information is much simpler and easier to read when 

included within the text of the report. 

During our audit period, the director of the Massachusetts Chocolate Regulation Board inappropriately used over 

$3 million of state funds to purchase vehicles for himself and his employees, as detailed below: 

Cars Purchased by Director 

Car Make and Model Cost 

Koenigsegg Regera $1,900,000 

Mercedes-Benz SLR McLaren AMG 500,000 

Aston Martin Vanquish Zagato 653,000 

Total $3,053,000 
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In this example, the table does provide additional details that are not included in the body of the report. However, 

the information isn’t entirely relevant to the finding. Although it might be interesting to know the exact details, the 

major point of the finding can be made by simply stating in the text that the funds were spent inappropriately on 

vehicles. 

 

In this example, the graphic provides new information that is relevant to the finding. However, the same 

information could be easily conveyed in the body of the report, making the information simpler and easier to 

understand. 

Creating Tables 
Tables are one of the most common types of graphic that we use in our reports. They are effective because they 

allow us to lay out detailed information in a clear and concise way. However, as we discussed in the first section, 

we need to be careful not to use them when they aren’t really adding information to the report.  

This first step will apply to tables, charts, and graphs. In Word, in the bar at the top of the page, click on the Insert 

tab as pictured below: 

 

Next, click on Table. A drop-down menu will appear. This drop-down will allow us to build a table with the number 

of rows and columns that we need. 
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Note: Be sure to take into account header rows and total rows, if they are needed.  

Drag the mouse to highlight the appropriate number of cells. Clicking in the bottom-right cell you’ve highlighted 

creates the table: 

 

Now we have a table that is the exact size that we need. However, it doesn’t look much like the tables we’re used 

to seeing in our reports.  

The first step to making an OSA-approved table is changing its style. To do this, we first need to go to the Design 

tab, located under Table Tools. 

Hint: If these tabs aren’t visible, try clicking somewhere on the table. This should make the tabs appear. 

Now we should see a wide menu with many different table styles. To get to the one we want, click on the drop-

down option in the bottom-right corner of the box, as illustrated below. 
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This will bring up an even bigger list of style options. Choose “List Table 6 Colorful – Accent 1”. 

 

After clicking this option, our table should have the correct colors and borders. 

However, there’s still one more aspect we need to change to make our table fit the OSA standard: text style. 

To do this, we first need to highlight our entire table by clicking the box in its upper-left corner. Then, in the Home 

tab, look for the section labeled Styles and click the drop-down in the bottom-right corner. 

Light Shading-Accent 1 
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This drop-down will give us a list of all of OSA’s text styles. For a table, choose _Table Text. 

Now, our table should have all of the appropriate styles applied and be ready for us to insert our data. The picture 

below shows an example of a finished product. 

 

A few things to note: 

 Table title – If your table has a title, use text style _Table Title. Remember to be consistent: if one table in 

the document has a title, all of the others should as well.  

 Headings – Our tables will almost always have column headings. Word will automatically put them in bold 

if the table is in the _Table Text style. 

 Table notes – If you are including notes on a table, do not use footnotes. Instead, put them directly below 

the table and use the Table Note style. 

 Alignment – General text is center-aligned. However, note the second column in the sample table; 

because it contains dollar amounts, it is right-aligned. 



Guide to Using Graphic Elements 

7 
 

 Dollar amounts – When a column contains dollar amounts, only the first and last amounts should have 

dollar signs. You should also insert a tab (click Ctrl+Tab) after the dollar sign. 

 Totals – Any totals should have a double underline (available under the Home tab in the Font section) and 

subtotals a single underline. If the line above a total is not a subtotal row, it should have no underline. 

Creating Graphs and Charts 
There are a lot of different types of graphs that we could include in a report, but we’re going to focus on two of the 

most common types: bar graphs and pie charts. 

Using bar graphs 
For any type of chart, we’ll start by clicking on Chart in the Insert tab. 

 

This will bring up a dialogue box with all of the chart options listed along the left side. For a bar graph, click on 

Columns. 

As we can see in the picture below, along the top of the box, there will be several options for bar graphs. Toward 

the end of the list, we’ll see some very fancy-looking options with awesome 3-D effects: DO NOT USE THEM!!! 

They may look super-cool, but they do not fit OSA standards. 
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After we choose the graph type that best fits our needs, Word will automatically bring up an Excel spreadsheet 

where we can input our data. 

 

As you can see in the above photo, the default labels are all generic (Series 1, Category 1, etc.). Make sure that you 

replace these in the Excel spreadsheet with the correct labels. You can also use more/less rows/columns if you 

need more. Also, don’t forget to change the title of the chart. 

Once our data is in, Word will generate our chart. However, the default color scheme is not the OSA standard. To 

fix this, we need to make sure that we have the entire chart selected and that we’re in the Chart Tools tab, then 

click on Design. 

Hint: If this tab doesn’t appear, click on the chart. 

You may notice that the chart above does not have the same colors that you are used to seeing in an OSA report. 

It’s fine to leave the colors as they are, and the Editing department will adjust them. 

Below is an example of a finished product. 



Guide to Using Graphic Elements 

9 
 

 

 

A few things to note: 

 Graph titles – Graphs should have titles to help the readers understand the context of the information. 

 Axis labels – Both axes in the table need to have scales and/or labels so readers can understand the 

information. 

If your graph is missing the axis labels, start by right-clicking the axis. On the menu that pops up, select “Format 

Axis.” This will bring up another set of menus on the right side of the page as shown below. 

 

You can use the dropdown menu to display the correct units. Keep in mind that your axis labels should start at 0. 

This is what readers expect, and anything else is misleading. 

An important but often neglected aspect of graphs is the caption. We can find the caption box in the Audit Report 

Template and simply copy and paste it to where we need it. Captions are essential for helping readers understand 

graphs and are required for all graphs. The key to creating a caption is to ask ourselves what we want the reader to 

take away from the graph and summarize it in one sentence. Below is an example of a caption that would work 

well with our sample graph. 
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Using pie charts 
The steps for creating a pie chart are almost identical to those for creating a bar graph.  

First, go to the Insert tab and click Charts. 

From the list of options on the left side of the dialogue box, choose Pie. DO NOT choose one of the options with 3-

D effects.  

Then, insert the data in the spreadsheet and update the color scheme to fit OSA standards. Note that the title of 

the chart appears at the top of the second column in the spreadsheet. 

There is one extra step with pie charts. The default style places white space between the sections on the chart, 

which is not standard OSA style. To fix this, go to the Chart Tools tab and click the Format tab. Click on the option 

for Shape Outline (in the Shape Styles area) and choose No Outline, as shown below. 

 

These steps will give us an OSA-approved pie chart. Below is an example of a finished product. 

During the audit period, the auditee purchased more rat toys than either cat toys 

or dog toys. 
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While this is a perfectly nice chart, now we’re going to talk about something extra that we can add that is 

especially useful in a pie chart: percentages. 

To add percentages to our chart, right-click on the chart and select Add Data Labels. 

 

This will label the chart with simple numbers. To change them to percentages, right-click again and select Format 

Data Labels. 

This will bring up a menu with options for changing our data labels. We can select “percentages” and de-select 

“value.” There are also other options to create different types of labels. 
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If you don’t want the percentages to appear inside of the pie chart, you can choose the option to use leader lines. 

Click the boxes marked “Show Leader Lines” and “Outside End” as shown below. 

 

The finished product will look like this: 
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Note that for this chart, we’ve used a slightly different caption. Most likely, if we’re using a pie chart, we’re more 

interested in the relationships specific categories have to the whole than in the amounts. Thinking about why we 

chose the type of graphic that we did can help us determine what to include in our caption. 

Using Photographs or Scanned Documents 
In some cases, a finding might be easier to understand if we include photographs or scanned documents. These 

types of graphics are acceptable according to OSA standards; however, as with any other graphic, make sure that 

photos and documents are relevant to the report and add something to the text. 

For both photos and documents, an important OSA rule to remember is to always put these graphics in an 

appendix rather than in the body of the report. Because these graphics take up a lot of space, they can distract 

from the finding if not placed in an appendix. 

Using photographs 
When using photographs, it is important to include captions that describe what is in the photos and give the 

reader an idea of why the photo is being included. 

To insert photos, follow these steps: 

First, create a table with two columns, and as many rows as we need (one row per photo). Keep this table plain, 

without any styles or formatting. (See the Creating Tables section for more information.) 

Once the table has been created, insert the photos in the left column by using the “Insert” option and type the 

captions into the right column. 
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After our photos and captions have been added to the table, navigate to the Table Tools tab and click on Design. 

Hint: If these tabs aren’t visible, click on the table and they should appear. 

Click on the drop-down labeled Borders and select No Borders. This will make the outlines of the cells invisible. 

Note: The entire table must be highlighted/selected before we can remove the borders. 
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Using documents 
Including a document in the report follows similar rules, but with a slightly different format than photographs. We 

should still place the image in an appendix and include a caption that describes the document and tells readers 

what they should know about it. However, because a document is likely to be larger than a photograph, we 

wouldn’t use a table format. 

 

As this example illustrates, one easy way to include a caption for this type of graphic is to write a brief paragraph 

before the image that provides the necessary information.  

Note that in this example, the caption directs the reader by pointing out exactly what aspect of the document is 

problematic, explaining why we’ve chosen to include it.  

Considerations for Readers Who Are Visually Impaired 
Recently, OSA has been working on making reports more accessible to people with visual impairments, as required 

by law. Graphic elements can be particularly challenging, so this section will provide some guidance. 

Problematic types of graphics 
People with visual impairments typically use devices called screen readers to experience texts. These devices read 

the text aloud. Certain types of graphics are nearly impossible for these devices to read because of the way they 

function.  

One example is maps. Because screen readers read text from left to right across the page, maps are particularly 

challenging. Look at the graphic below and try to imagine how a screen reader would interpret it. 
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Households Using Netflix in Fiscal Year 2017

 

Because of how difficult it would be for a screen reader to interpret this map, we discourage using them in reports. 

Instead, explain the important take-away points in the body of the report. If you think a map would be helpful and 

important to the report, make sure to include a caption. 

Issues with charts and graphs 
Charts and graphs, such as the bar graphs and pie charts discussed in the previous sections, can raise problems of 

their own. (This is why we recommended earlier that graphic elements be used only when necessary.) For 

example, the chart below would pose problems for a screen reader: 

 

Luckily, it is possible to make this chart accessible to people with visual impairments. The answer lies with our old 

friend, the caption. Because captions are formatted as standard text, screen readers can easily read them as they 

would any other text. 
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However, note that while the caption is useful for helping the reader understand the main point of the text, it still 

can’t give them all of the detailed information that the graphic does. For this reason, it is still important to use such 

graphics sparingly.  

The same applies to photographs and documents. While captions give the important take-away points, they do not 

allow the reader to fully experience the graphic. 

Issues with tables 
Of all graphic elements, tables are the least problematic for screen readers. Because text in tables is laid out in the 

typical left-to-right orientation, people using screen readers can more easily navigate them. However, there are 

still some problems to be aware of. For example, take a look at the table below: 

Days to Comply with Blender-Ownership Law 

District Number of Days 

Narnia 122 

Panem 59 

Tatooine 72 

Mordor 15 

Pandora 101 

Storybrooke 55 

Winterfell 87 

Atlantis 71 

Camelot 28 

Average 67.8 

   In compliance with 60-day timeframe 
 

This is a standard table using OSA-approved styles. However, the table illustrates certain information by 

highlighting certain cells in a different color. Screen readers cannot recognize differently colored cells, so this 

information would not be accessible to people using screen readers. 

One way to fix this would be to include an additional column giving the same information: 

A majority of consumers use either Netflix or Hulu streaming services. 
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Days to Comply with Blender-Ownership Law 

District Number of Days In Compliance?  

Narnia 122 No 

Panem 59 Yes 

Tatooine 72 No 

Mordor 15 Yes 

Pandora 101 No 

Storybrooke 55 Yes 

Winterfell 87 No 

Atlantis 71 No 

Camelot 28 Yes 

Average 67.8  

This version of the table is fully in compliance with OSA standards and is entirely accessible to readers with visual 

impairments. 

One final note about tables: Try not to put too much information into a table. Your OSA colleagues are responsible 

for converting all of that information into a screen-reader format, so keep them in mind when putting together 

tables. 


